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Disclaimer or Warranty and Limited Warranty on Media

If you are not completely satisfied with this software at any time during the first 30 days after
you receive it, return the software and manual, postage prepaid, during the 30-day time period,
with proof of purchase to your dealer, for a full refund of the purchase price of the product. At
your option, you may include the reason for your dissatisfaction.

“NO HANDS SOFTWARE AND ITS LICENSOR(S) ‘LICENSOR” MAKE NO WAR-
RANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
REGARDING THE SOFTWARE. LICENSOR DOES NOT WARRANT, GUARANTEE, OR
MAKE ANY REPRESENTATION REGARDING THE USE OR THE RESULTS OF THE USE
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY,
CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PER-
FORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF
IMPLIED WARRANTIES IS NOT PERMITTED BY SOME JURISDICTIONS. THE ABOVE
EXCLUSION MAY NOT APPLY TO YOU.”

“IN NO EVENT WILL LICENSOR AND THEIR DIRECTORS ,OFFICERS, EMPLOYEES,
OR AGENTS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, OR
INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE)
ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE EVEN IF LICEN-
SOR OR SUCH PARTIES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAM-
AGES. BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIM-
ITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE
ABOVE LIMITATIONS MAY NOT APPLY TO YOU. Licensor's and such parties liability to
you for actual damages from any cause whatsoever, and regardless of the form of the action

(whether in contract, tort (including negligence), product liability, or otherwise), will be limited
to $50.”

Trademarks

No Hands Software, the No Hands logo, and Common Ground are trademarks of No Hands
Software. Macintosh, AppleTalk, AppleShare, Apple, Mac, LaserWriter, Image Writer, and
AppleLink are registered trademarks of Apple Computer, Inc. PowerBook, FileShare, and
Finder are trademarks of Apple Computer, Inc. PageMaker is a registered trademark of Aldus
Corporation. PixelPaint Professional is a trademark of SuperMac Software. MacDraw and
MacPaint are registered trademarks of Claris Corporation. MacDraft is a registered trademark of
Innovative Data Design. Inc. MacRecorder is a registered trademark of MacroMedia Inc. Times
and Helvetica are registered trademarks of Linotype Corporation. ITC Avant Garde and ITC
Bookman are registered trademarks of International Typeface Corporation.



Copyright

The Common Ground manual and program are copyrighted by No Hands Software. Your rights
of ownership are subject to the limitations and restrictions imposed by the copyright laws as out-
lined below.

[t is against the law to copy, reproduce, or transmit, including without limitation electronic trans-
mission, over any network, any part of the manual or program as permitted by the Copyright Act
of the United States, Title 17, United States Code. This license is for electronic document distri-
bution and not electronic publishing. This means YOU MAY DISTRIBUTE A COMMON
GROUND DOCUMENT TO NO MORE THAN 100 USERS. DISTRIBUTING OR PUB-
LISHING SUCH A DOCUMENT TO MORE THAN 100 USERS IS EXPRESSLY PROHIBIT-
ED BY THIS LICENSE. You may also distribute the Common Ground MiniViewer when
embedded in a document as described in the manual. To otherwise copy, reproduce or transmit
documents or the Common Ground Viewer, contact No Hands Software in the U.S. at (415) 802-
5800 or fax (415) 593-6868 for more information. Under the law, copying includes translation
into another language or format. However, you are permitted by law to make working copies of
the program, solely for your own use, subject to the following restrictions: (1) Working copies
must be treated in the same way as the original copy; (2) If you ever sell, lend, or give away the
original copy of the program, all working copies must also be sold, lent, or given to the same
person, or destroyed; (3) No copy (original or working) may be used while any other copy (orig-
inal or working) is in use except within the terms of this license. The copyright notice that is on
the original copy of the program must accompany any working copies of the program.

The above is not an inclusive statement of the restrictions imposed on you under the Copyright
Act. For a complete statement of the restrictions imposed on you under the copyright laws of
the United States of America see Title 17, United States Code.

The No Hands Team:

Software Engineering: Nick Gault, Andy Nuss, Steven Marcus
Management: Nick Gault, Tony Stayner, Tammy Herrera
Interface Design: Nick Gault, Andy Nuss

Testing: Tony Knight, Bill Leasure and our beta testers
Packaging: Steve Lyons, Randall Hull

Manual: Robert Remillard, Tammy Herrera

Program and Manual © 1993 No Hands Software.



INTRODUCTION

Welcome to the No Hands family of satisfied customers. We are committed to delivering to you
superior products and exceptional customer service. If you have any suggestions regarding this
or any of our other products, please contact us at (415) 802-5820. We want to know what you
are thinking so that we may continually improve our products.

Digital Communication

How many times have you sent or received a file that is unusable because it can’t be opened,
viewed, or printed? Worse yet, have you opened a document only to find the fonts replaced or
missing and the entire format ruined?

Common Ground software changes all that. Common Ground uses our DigitalPaper™ technol-
ogy, which lets you create and distribute a document that is pixel-for-pixel identical with the
original. A document that can be viewed or printed by any Macintosh user — even if they don't
have the creating application or fonts. Distribute documents company-wide or send a newsletter
to a colleague or client, always knowing that everyone will be able to use the document.
Electronic document distribution has other benefits. Common Ground documents reduce the
desire to pirate the creating software application and will save your organization a bundle in
paper costs.

DigitalPaper

DigitalPaper is meant to have many of the properties of regular paper. If [ give you a piece of
paper, I know you will be able to view it as it was created. Paper is a medium that places virtu-
ally no requirements on the recipient. Similarly, DigitalPaper places few requirements on the
recipient. Digital Paper is platform independent (versions for other platforms will be available
in 1993), and may be viewed without the creating application and fonts. In each case, the recipi-
ent will see a document that is pixel-for-pixel identical with the original.

DigitalPaper has many advantages over paper. With DigitalPaper, you can electronically search
the document for text and can copy and paste freely. Or even save out to PICT or text for further
editing. In the future we will add features to our Digital Paper based products to give them fur-
ther advantages over regular paper.

Common Ground is easy.

To free your documents from the constraints of your own system configuration, System 7 users
can simply drag and drop your document onto the Common Ground AutoMaker icon. Other
users will just print from any application after selecting the CG Maker printer driver from the
Chooser. Common Ground does all the rest, instantly creating an identical document which can
then be viewed anywhere with the Common Ground Viewer. Or better yet, enclose our Mini-



Viewer with the document at the time of creation, so the recipient will be able to view your doc-
uments even without the Common Ground Viewer.

Portable documents let you share information.

Common Ground eases the flow of information between you and your colleagues by ensuring
your documents can be viewed and printed on any Macintosh. And by enclosing our compact
Mini-Viewer with the Common Ground document when it is created, the recipient will need
nothing else to view your document, making it truly portable.

Common Ground’s powerful features

e The Universal Solution

Virtually any document in any application can be transformed into a Common Ground document
using our cross platform, universal display language. And Common Ground works transparently
with all fonts, including PostScript® and TrueType™.

e Pixel-for-Pixel Identical Documents

Our DigitalPaper technology captures all the information about the fonts used in your document
and provides a pixel-for-pixel representation of your original document. Common Ground docu-
ments not only appear perfect on screen, they print perfectly as well: At a precise, 300 dpi reso-
lution.

o Search, copy, and paste freely

A Common Ground file is not a mere bit-map copy of your document. Each Common Ground
file contains text and graphics you can search, copy, and paste into other documents. You can
even save out to text or PICT file formats for further editing.

. Maximum security
All Common Ground files can be secured to prevent unwanted copying, and printing. All docu-
ments can be password protected and DES encrypted as well for additional privacy.

] Attach Sounds to Documents.

Sounds can be notes you record to describe the document or prerecorded sounds that enhance
the document.

] Powerful Text Search

In addition to searching for whole words and exact case matches, you can also generate a list of
all occurrences of the found text and the page on which each occurrence appears.



Who can benefit from Common Ground?

Common Ground makes life easier for anyone who needs to exchange text with special fonts
and complex graphics. People who find Common Ground useful include:

. Writers/Designers/Editors

Common Ground lets writers and designers send brochures, ads, newsletters, and other docu-
ments they create to their clients and editors for review. The clients and editors can then view
and print all the information without having to own the programs that created the documents.
Designers will especially appreciate being able to enclose a Mini-Viewer with their Common
Ground document, so they can electronically send a comp of their work to a client, knowing that
the client will be able to view it, even without the Common Ground Viewer.

o Business People

Common Ground allows executives, managers, and sales people to exchange sophisticated pro-
posals, memos, and other business communications that contain special fonts and graphics,
knowing that the recipient will be able to view and print a document that is pixel-for-pixel iden-
tical to the original.

o Engineers and Drafters
Anyone who creates drawings can use Common Ground to send their drawings to other people
for review.

o Faxless People

People without fax machines can receive Common Ground documents on disk or over a modem
and print out the documents. Also, because Common Ground documents support 300-dpi print-
ing, the quality of the output is better than faxes.

e Bulletin Boards

Organizations that use electronic bulletin board systems (BBSs) can use Common Ground to dis-
tribute information to their subscribers. Common Ground documents containing announce-
ments, calendars of events, job listings, and other types of information can be downloaded and
used by subscribers. Because Common Ground lets you embed a Mini-Viewer to create a self-
launching document, you know that everyone will be able to access the information you’ve post-
ed and view it with the fonts and graphics intact.



CHAPTER 1

CHAPTER 1 — Getting Started

The following sections cover system requirements and installation.

Software and Memory Requirements

. Common Ground will work on any Macintosh running System 6.0.5 or later or System
7.0 or later.
. A minimum of 700 K of free memory is required to run Common Ground. This means

you must have 2 Mb of memory under System 6.0.x and 3 Mb under System 7.

Installing Common Ground

Common Ground should be installed on your hard disk. Before you install Common Ground,
make a copy of the program diskette and store the original in a safe place, away from heat,
humidity, or anything magnetic like speakers, ringing telephones, and so on.

Common Ground is shipped on the Common Ground disk and consists of these files:

] Common Ground
] CG Maker
] CG AutoMaker

The procedures for installing Common Ground under System 6.0.x and System 7 are nearly
identical. These instructions assume you know how to select and copy files. If you are not sure
how to do this, see the book Macintosh Reference, which was shipped with your computer.

To install Common Ground:

1. Insert the Common Ground diskette into a floppy drive in the Macintosh.



2. The disk opens in a window.
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3. Select and copy the Common Ground and CG AutoMaker files onto your hard disk.

Tip: Move the CG AutoMaker onto the desktop to make it easier to access when you use it
to generate documents.

4. Select and copy the CG Maker file into your System folder. If you are using System 7,
an alert dialog box will ask if you want to put the file in the Extensions folder. Click
OK.

5. Restart your Macintosh.

That's it! You’re ready to get started using Common Ground.



CHAPTER 2

CHAPTER 2 — Quick Start

This chapter takes you through the process of creating and viewing a Common
Ground document.

Before you create a Common Ground document, make sure you have installed the Common
Ground software. See the section, “Installing Common Ground,” in Chapter 1 of this document
for installation instructions.

Using the AutoMaker to create a Common
Ground document

The easiest way to create a Common Ground document is by using CG AutoMaker. CG
AutoMaker lets you create Common Ground documents by simply dragging and dropping a doc-
ument in the Finder. This saves you the trouble of opening the original document. CG
AutoMaker uses certain default settings to automatically create Common Ground documents.
(You can use the Common Ground printer driver if you want to choose page setup and print
options. See the sections below for more information.)

Note: This feature is only available if you are running System 7. See the sections below for
instructions on choosing options for Common Ground documents and creating documents
using System 6.0.x.

To create a Common Ground document using the AutoMaker:

1. Go to the Finder.

Open the folder that contains the document you want to use to create a Common Ground
document.

3. Make sure the CG AutoMaker icon is visible on the screen. If CG AutoMaker is in a
folder, open the folder.

4. Drag the document on top of the CG AutoMaker icon. The CG AutoMaker icon should
highlight.

5. Release the mouse button when the CG AutoMaker icon is highlighted. A new Common
Ground document appears next to the original. The Common Ground document is
named after the original document, but with the extension “.dp” at the end of the docu-
ment name.



Creating a Common Ground document from within an
application

The first step in creating a Common Ground document is to open a document in another applica-
tion. You can use any application you want (so long as it supports the standard Macintosh Print
command). The document should contain more than one page and at least a few lines of text to
work best with this example. (See the manual that came with the application for information on
starting the application and opening documents.)

Selecting the CG Maker Printer Driver

You use the CG Maker printer driver to create Common Ground documents. Once you install
the Common Ground software, the CG Maker printer driver appears in the Chooser dialog box.

To select the CG Maker printer driver:

1. Pull down the Apple (#) menu and select Chooser. The Chooser window opens.
2. Click the CG Maker icon. The icon is highlighted.
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3. Click the Close box in the Chooser window. The window closes. Click OK to close the
alert dialog box that prompts you to change the page setup.

Defining the Page Setup

After you change printer drivers, you need to define the page setup for the chosen device (print-
er, fax/modem, and so on). In this case, you define the page setup for the Common Ground doc-
ument you will create.



To define the page setup for the document:

1. Go back to the application and select the File menu and choose Page Setup. The first
time you create a Common Ground document, you are asked to personalize your copy of
the CG Maker. Type your name into the Name box. Then click in the Company box or
press the Tab key. Type your company name. Click OK. The Page Setup dialog box
opens.

Common Ground™ Page Setup v 1.0
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The default settings should work fine in most cases, so just leave them as they are.
2. Click OK to close the Page Setup dialog box.
Choosing Printing Options

Common Ground gives you many options when you create a new document. These options let
you:

o Choose the range of pages to be included in a document

o Prevent people from copying text and/or graphics in a document
o Encrypt a document with a password

. Attach a sound

o Include high resolution information for printing

e Include a Mini-Viewer

These options are accessed in the Print dialog box. All these options are described in detail later
in the Common Ground manual. See Chapter 3 “Creating Common Ground Documents” for
information.



To create the Common Ground document:

1. Open the File menu and choose Print. The Print dialog box opens.
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Once you click OK in the Common Ground dialog, you will be asked where you want to save
the Common Ground document.

Working With the Common Ground Document

You can now open the Common Ground document you created. If you included high resolution
information in the document, you can print the text and graphics at the highest possible level of
quality. In addition, text and graphics can be selected and copied for use in other applications.

Opening other documents

You can use the Common Ground program to open Common Ground, and several other types of
documents. In addition to Common Ground documents, you can open documents saved in these
formats:

] MacPaint
] PICT
. Text

Thus Common Ground can be used as a general 'generic' document viewer.



Using the Tool Palette

The Tool palette contains the tools you use to select text and graphics and zoom in or out from a
document. You can open and close the Tool palette and move it to a convenient place on the
screen.

Grabber Magnifier

Lasso I-beam

Marquee Arrow

Tool palette
To close the Tool palette:
. Click the Close box in the Tool palette or press the Spacebar. The Tool palette disap-
pears from the screen.

To open the Tool palette:
. Open the Windows menu and choose Tools. The Tool palette opens.
To move the Tool palette:
1. With the arrow selected, point to the title bar on the Tool palette.
2. Press and hold the mouse button, then drag the Tool palette where you want it.

3. Release the mouse button when you are finished.



Searching for Text

Use the Find dialog box to locate text in a document. You can restrict the search to text that
matches certain criteria and locate all occurrences of text.

O=————— Find

Search for: || |

OJWhole Word []Case Sensitive []Find All Occurrences

Searching in document "Diewer.doc.3pa..."

To find text in a document:

1. Open the Edit menu and choose Find. The Find dialog box opens.

2 Check the Find options you want. Click a box to check it. The Find options are
described below.

3. Type the text you want to find.

4. Click the Find button. The program highlights the first occurrence of the specified text

in your document.

Note: You may always close the dialog box after an occurrence is found by clicking in the
dialog close box.

5. Click the Find Next button to find the next occurrence of text in the document. The next
occurrence of text is highlighted. When the program reaches the end of the document, a
dialog box appears.

6. Click OK to resume the search at the beginning of the document; click Cancel to stop the
search.

Section Guides

Section guides allow you to define sections you want to treat as discrete areas, such as columns
and rows. When you first open a Common Guide document that contains text laid out in
columns or columns and rows, the program doesn’t initially recognize the special layout. For
example, without section guides, if you select text on a page with columns, all the lines of text
across the page are selected, not just the text in a certain column. If you use vertical section
guides to define the columns, however, Common Ground lets you select the text in the individ-
ual columns. You can use horizontal column guides to define rows in tables and spreadsheets.
Once you define the sections on a page, you can easily select the part of the column or row you
want to copy using the I-beam tool.



To place a section guide:

1. Open the Windows menu and choose Section Guides. The Section Guides palette opens.

Drag the palette by its title bar to move it. Click it's Close box or press the Spacebar to close it.
When the Section Guides palette is closed, the section guides placed on the page are hidden.

2. Click the Vertical or Horizontal section guide tool, depending on which one you want.

3. Point where you want the section guide to appear. The pointer changes to the Section
Guide pointer. A plus sign appears in the pointer to show you are ready to add a new
section guide.

4. Press and hold the mouse button, then drag to precisely place the section guide. Or, sim-
ply click the mouse button. A section guide appears at each point you release the mouse
button.

For more information on using section guides, see the Common Ground manual.

Using the Mini-Viewer

As an option, a Mini-Viewer can be included in a Common Ground document. The Mini-
Viewer lets anyone open a Common Ground document as long as the document is not password
protected. The Mini-Viewer let anyone view on screen a Common Ground document, but not
search in or copy from the document.
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To open a Common Ground document that contains a Mini-Viewer:

) Double-click the Common Ground document icon in the Finder.



To display a different page:

. Open the Page menu and choose Next to display the next page; choose Previous to dis-
play the previous page.

To close the document:
. Open the File menu and choose Quit. The document closes and the Mini-Viewer quits.



CHAPTER 3

CHAPTER 3 — Tips and Troubleshooting

Important Tips

Below are some useful tips for getting the most out of Common Ground.

Printing
* When do1 not need to use the ‘Include high resolution information for printing” option?

When you create a Common Ground document using this option, you achieve the best possible
quality under all circumstances. This option may however also slow down printing. If the fonts
in the document are to be available on your viewing system, you can save time by not selecting
this option. Check ‘Document Fonts’ under the Windows menu to see the fonts the viewing sys-
tem will need for high resolution printing if you do not select this option.

If you are only concerned about viewing the Common Ground document on the screen, you do
not need to include the high resolution information for printing.

If you are using SuperATM, you do not need to include the ‘high resolution printing’ informa-
tion since SuperATM will generate such information itself.

If you are trying to achieve the smallest possible file size, you may not want to include this
information as it can significantly increase the size of the file.

Mini-Viewer
¢ How i1s the Mini-Viewer different from the Common Ground Viewer?

The Mini-Viewer is significantly smaller than the Common Ground Viewer, thus keeping the
size of the file small while allowing someone without Common Ground to view your docu-
ments. Enclosing the Mini-Viewer creates a self launching document that anyone can view or
print. However they will need the full Common Ground Viewer to be able to search or copy
from the document.

The Mini-Viewer can not be included with Common Ground documents that have been encrypt-
ed or that included recorded sounds.



Working with Color
. How can color affect the size of my documents?

Common Ground creates documents based on the bit depth of your monitor. If your monitor is
set to millions of colors when you create a Common Ground document, the document will con-
tain millions of colors even if your document is only black and white text. The most effective
way to keep your documents small is to set your monitor to the highest bit depth of the docu-
ment. In the case of a black and white text only document, you should set your monitor to black
and white and then create the document.

Selection and Copying Options

Common Ground gives you lots of flexibility in selecting text and pictures in a document.
Below is a list of the various options available for selection and copying.

NOTE: If you wish to copy all the text from a Common Ground document, you can use
the Save As... command under the File menu to save a text file.

Lasso: Use the Lasso tool to select irregularly shaped pictures and text you want to
copy as a picture. The Lasso is also useful for accurately selecting pictures surrounded by white
space. The Lasso intelligently selects only the picture and leaves out the white space.

Marquee: Use the Marquee tool to select rectangular pictures and large chunks of text.
When you use the Marquee tool, you have the option of copying selected pictures as bitmaps or
PICT objects and selected text as a bitmap, PICT object, or as a series of characters (text).

I-beam: Use the [-beam tool to select from one character to many pages of text. After
you select the text, you can copy it and then paste it into a word processing, page layout, or
spreadsheet program and edit it.

Section Guides: Use section guides to define sections on a page. Section guides let you define
areas on pages that are laid out in columns and rows, for example, multi-column newsletters,
tables, and spreadsheets. After defining the sections, you can use the I-beam or Marquee tool to
casily select text in the sections you want.

See the section, “Using the Tool Palette” in Chapter 4 “Viewing Common Ground Documents”
in Common Ground manual.c. for information on using the Lasso, Marquee, and [-beam tools.
See the description of section guides in Chapter 5 “Common Ground Command Reference” for
information on using section guides.

Copying: After you select a picture, you can choose to copy it as a bitmap or as a PICT
object. You can also copy text as a bitmap, PICT object, or as a series of characters. Bitmaps
are commonly used in paint programs (such as MacPaint). Once in a paint program, you can



edit the individual pixels (picture elements) that make up the bitmap. PICT objects are com-
monly used in drawing programs (such as MacDraw). PICT objects are composed of a series of
lines and geometric shapes (such as circles and rectangles). You might want to copy text as a
bitmap if you want to paste the text into a paint program and apply some special effect to it (such
as skew, distort, or perspective). If you want to be able to edit the characters in the text and use
it in a word processing or spreadsheet program, you need to copy it as text or as a PICT object.
You can select all and copy as a PICT. You can now go to a drawing program and paste. Once
you select the ‘Ungroup’ feature, all the individual components of the original document will be
editable. See the description of the Marquee and [-beam tools in Chapter 4 “Viewing Common
Ground Documents” for instructions on using the copy options.

NOTE: When copying text from Common Ground, the pasted fonts might be different
from the fonts used in the Common Ground document. If the fonts used in the Common
Ground document are not present, the text will be pasted using the default system font. If
the fonts are present, the text will be pasted correctly.

Technical Support

If the previous troubleshooting section has not solved your problem, the No Hands Technical
Support Department is available to help you. The No Hands Technical Support Department can
be reached by calling (415) 802-5820. No Hands Software also maintains support forums on
AppleLink, CompuServe, and America OnLine. Our AppleLink address is NOHANDS, our
America OnLine address is NoHands, and our CompuServe address is 74740,2142.

What to do before you call:
Before calling Technical Support, please have the following information ready. This will aid us
in answering your question quickly and efficiently.

1. Have your original diskettes or upgrade diskettes with your registration number.
2. Be prepared to describe your computer setup as thoroughly as possible.
3. How repeatable is the problem? Does it happen every time, only sometimes, or only

once?



